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This guide is designed to be used in conjunction with attendance in training classes provided 
by the Banner Training Team.  
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Goals 
The goal of this guide is to provide the knowledge and needed information to accurately navigate within 
Banner and understand all necessary concepts, features, and terms.  
 

Intended Audience  
This guide is designed to assist all those functional areas that will be using Internet Native Banner (INB) for 
day-to-day operations.  
 

Pre-requisites 
In order to attend this class, participants should have the following pre-requisites:  

 Basic keyboard and mouse skills  
 Internet familiarity  

 

What is Banner?  
Banner is a web-based software application developed specifically for higher education institutions by a 
company called SunGard SCT. Banner provides an online environment that will allow YSU to perform 
computing functions in a highly efficient manner as all data will now be totally integrated and shared among 
different departments across the University.  
 
Banner comes in two distinct options: Internet Native Banner (INB) and Self-Service. Employees in the 
functional areas will be using the Internet Native Banner option.  
 

System  
A system is a term used in Banner to describe an overall area of administration within Banner. For example, 
Finance and Human Resources are both systems within Banner.  
 

Module  
A module is an area of administration within a system. For example, Accounts Payable is a module 
under the Finance System.  
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A Web communication portal that 
provides highly personalized 
information, Web services and 
community interaction to every 
campus constituent—from 
faculty and students to 
administrators and alumni. 

Banner and its 
connection to 

operations at YSU 

Banner 

1. Finance 2. Advancement 
Alumni/Development 

3. MyYSU  
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4. Student 

5. Financial Aid 

6. HR/Payroll 



Logging into Banner  
Banner is a web-based program. To use it, open an Internet Browser (browsers 
include Microsoft Internet Explorer, Netscape Navigator, etc.) and log into 
Banner.  

1 Open Internet Explorer  
2 Type: http://banner.ysu.edu <press enter>  
 
Internet Native Banner is available in two modes: training and production. Training INB provides the ability 
to perform the processes in this manual without harming real University data and will be used during the 
training class and for individual practice. Production will be used to accomplish actual University activities. 
 
1 Locate Internet Native Banner  
2 Click Training Database [TRNG]  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
Banner has a 3-hour timeout limit established.  However, if you are not using the product, please exit 
properly before the timeout limit has been reached. 

The first time you login to INB, a program called Oracle JInitator will download. Click all necessary 
buttons if prompted for downloads and installs. This is a one-time download.  
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 Quick Tip 

 Quick Tip 



Interface Overview and Menus  
Menus provide a method for navigation throughout Banner.  
 

Main Menu  
The main menu provides an overview of the menus, forms, jobs, and QuickFlows in Banner. The main 
menu is the primary method for navigating through Banner.  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 

 
 
 
 
 
 
 

Double-click on the folder to expand any of these areas in the main menu; continue double-clicking on 
the remaining folders until the form icon appears.  Double-clicking on the form icon retrieves the form. 
Double-clicking on an open folder closes the folder. 
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Menu Bar 

Toolbar 

Product Links Go To Field 

Hierarchical 
Tree Menu 
Structure 

My Link 
Canvas

Broadcast Message Canvas 

Auto Hint 

 Quick Tip 

Status Line 
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Product Links  
Provide for access to SCT Banner modules directly.  
 

 
Click and hold the dropdown arrow on the Products link to 
select the system. 
 

 

Site Map  
The site map lists top level menus and one level below. No fields are listed, just links to various menus and 
forms.  
 

 
Menu Bar  
This familiar Windows menu bar is located at the top of every form and contains 
pull-down menu choices. If a menu item is dimmed, it is disabled and cannot be 
accessed. 

 
 

 

Site Map 
Product Links 

 Quick Tip 
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Forms 
A form is an online document where information is entered and retrieved. Forms visually organize 
information so it is easier to enter and read. A form is similar to a paper document except information is 
entered once and is used by other Banner forms. Forms are comprised of fields. Data is entered into fields.  
 

Types of Forms 
Forms can be categorized as being either set-up or day-to-day. Set-up forms need to be completed during 
implementation and before day-to-day forms are used. Validation, rule, and control forms are Set-up forms 
used to tailor INB to YSU’s requirements. Revisions can be made to these forms any time--provided a 
security level permits. Day-to-day forms would be inquiry, application, query, maintenance, and wizard.  
Internet Native Banner uses eight types of forms:  
 
Main menu (GUAGMNU): used to navigate through INB. It provides an overview of the menus, forms, 
jobs, and QuickFlows available in Banner.  
 

Set-Up Forms  
Validation forms: used to define the values that can be entered in specific fields on application forms. 
These values are used throughout INB. When you look up a code or select the List function, these values 
appear in the List of Values (LOV) window.  
 
Rule forms: used to define the calculations and parameters that impact processing on other forms, reports, 
and jobs.  
 
Control forms: used to define the processing rules for application and validation forms at the system level.  
 

Day-to-Day Forms  
Application forms: used to enter, update, and query information. This is the most common type of form. 
  
Query forms: used to look up existing information, often returning information to the calling form. These 
forms are accessed from another form—they cannot be accessed directly from the main menu, with direct 
access, or with object search.  
 
Inquiry forms: used to look up existing information, often returning information to the calling form. These 
forms can be accessed from the main menu, from another form, with direct access, or with object search.  
 
Wizard forms: used to give step-by-step instructions for completing an application. There are 
very few of these form types.  



Form Naming Conventions 
Each form in Banner has a seven (7) character name – this name is an acronym which identifies the type of 
information the form contains, the University business process it is related to, and much more. See the chart 
at the end of the document. 
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• Advancement (A)  
• Finance (F) 
 • General (G) 
 • Position Control (N) 
 • HR/Payroll/ Personnel (P)  
• Financial Aid (R)  
• Student (S) 

 • General Person (P) 
 • Application (A)  
 • Budget (B) 
 • COBRA (C)  
 • Benefit/Deductions (D)  
 • Employee (E)  
 • Electronic Approvals (R) 
 • “Overall” to a business     
    process (O) 
 • General to a business  
    process (G)  

( )

 • Application (A) 
 • Inquiry (I) 
 • Validation (V) 
 • Maintenance (M) 

Examples:  
 • Identification (IDEN) 
 • Position (POSN) 
 • Encumbrance (ENCB) 
 • Employee (EMPL) 
 • Job information (JOBS) 
 • Requisition (REQN 
 • Check (CHEK) 

1 2 3 4-7 

S P A IDEN 

Position 1: 
Identifies the primary system owning the 
form.  

Position 2: 
Identifies the business process (module) 
owning the form.  

Position 3:  
Identifies the form type.  

Position 4-7: 
Uniquely identifies the form.  



Example:FPAREQN Example: SAAADMS Example: PHICHEK 

Position 1: Identifies the primary 
system owning the form F = Finance S = Student P = HR/Payroll/Personnel 

Position 2: Identifies the business 
process (module) owning the form P = Purchasing A = Admissions H = History 

Position 3: Identifies the type of 
form A = Application A = Application I = Inquiry 

Position 4-7: Uniquely identifies 
the form REQN = Requisition ADMS = Admissions CHEK = Check 

 

Accessing Forms 
There are multiple methods for accessing forms in Banner. 
 

Direct Access  
Use the Go field (or direct access) to open a menu or form by typing the seven-character name into the field 
and pressing the Enter key. The direct access command can also be found from the File menu or from 
within a form.  
 
 
 
 
 
 
 
 
 
 
 
 

 
 
Use the keyboard shortcut of F5 to access the Direct Access menu form within any Banner form. 

 
Last 10 Forms  
The File menu provides access to the Last 10 forms previously accessed during the current Banner session.  
Once the session has been exited, the forms are no longer available. 
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Object Search  
The object search opens the form GUIOBJS to enable searching of a form. When the correct seven-
character name code for the form is unknown, use the object search feature. Refer to the section on 
wildcard characters for additional information.  
 

Special Areas of a Form  
There are special areas that are very helpful to refer to on every Banner form.  
 

Auto Hint Line  
The auto hint line appears at the very bottom of the Banner window and can display various messages 
depending on what forms and features are being accessed in Banner. The auto hint line provides messages 
and hints about how to proceed while working in Banner. Examples of various messages are:  
 

 Brief field descriptions  
 Error and processing messages  

Auto Hint—field description 
 Keyboard shortcuts  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Status Bar  
The status bar is directly under the auto hint line and contains one or 
more of the following messages:  
Record n/n –shows the number of the current record followed by the total number of records in the 
current block. If there are more records than fit in the windows, the total appears as a question mark (for 
example, 3/?) until you scroll to the last record in the block. Once the last record is displayed, the total 
appears as a number (for example, 3/15).  

Enter-Query –indicates the form you are using is in query mode and can be used for searching. 
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Navigating in Forms  
There is no one way of using every form. Each form has its own purpose and its own method of usage. 
However, there are some navigational features that most forms do share.  
 
Windows 
A window is a framed portion of a form. Just as some paper forms have multiple pages, some Banner forms 
have multiple windows. The first window in a form is called the main window and is identified by the form 
name. All other windows in the form have their own unique names. More than one window can be open at 
the same time. The only limits are determined by the amount of memory installed on your computer. Not all 
windows are the same size, so you might see parts of more than one window at the same time. You can 
move a window by dragging its title bar to a new location. (You cannot move the title bar above the screen.) 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Window Panes  
A window pane is an area within a window that has more fields than can appear at one time.  Use the 
horizontal and/or vertical scroll bars at the bottom and/or right of a window pane to see the remaining 
fields in that pane. It may not be possible to view all fields at one time.  
 
If a window does not display a scroll bar, then all available fields can currently be viewed. 
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NOTE: Banner windows do not use the 
close button in the upper-right corner. 

NOTE: Use the Exit icon to 
Close all open Windows. 
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Tabs 

Window Pane Window Pane 

Scroll bar denotes more to 
the window 

Many, but not all, forms in Banner 7.0 have been combined through the use of tabs across the top of the 
form.   
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Blocks 
A block is a section of a form or window that contains related information. If a form or window contains 
more than one block, each block (except the key block) may be enclosed in a box. 
 

Key Blocks  
The first block on most forms contains key information and is the starting point of each form. This key 
block determines what is entered or displayed on the rest of the form. All information on the form refers 
to the key block.  
 
The key block: 
determines what is entered or displayed on the rest of the form. All information on the form refers to the 
key block; 
has at least one field and sometimes more; 
remains on the form as subsequent blocks appear.  
 
When the cursor is in the key block, enterable fields in the key block are enabled. When you leave the key 
block, enterable fields in the key block are disabled. 
 

Data Blocks  
A data block is a section of a form or tabbed window that contains information related to the key 
block—or chunks of information grouped together. If a form or window contains more than one block, 
each block (except the key block) may be enclosed in a solid line box or on a separate tab. 
 
Fields 
Fields are areas on a form where data can be entered, queried, changed, and displayed. The 
following terms describe a field: 
 

 Enabled. You can put the cursor in the field. Information in the field appears in black text. 
 Disabled. You cannot put the cursor in the field. Information (if it exists) appears in gray text. 
 Enterable. You can enter information in the field. The field is usually enabled. In certain situations, 

however, it may be disabled. 
 Display only. You cannot enter information in the field. 

 

List of Values (LOV): 
Many fields only accept codes from a defined List of Values (LOV).  Most codes and associated descriptions 
in a LOV are defined on a validation form. A drop-down arrow often appears next to the LOVs. When a 
LOV is called from a specific field, only information that is relevant to the current form is displayed in the 
LOV. 
 
With this feature you can: 

 Enter a complete code or description; 
 Look up a code or description based on a partial entry; 
 Display the entire LOV and select a code. 



Records  
Records are sets of related fields. If a block has multiple records, the records often appear in rows and 
columns. A horizontal scroll bar appears under the columns if all columns do not fit into the window at 
once. A vertical scroll bar appears on the right side of the rows if all rows do not fit into the window at 
once. When a row is selected, the entire record is highlighted to identify it as the current record. 
 
These areas can be accessed via the toolbars or through the Options menu.  

 
Toolbars and Buttons  
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TOOLBAR 

MENU  

Toolbars are a set of buttons or icons that offer quick access to commonly used Banner functions. A tool 
tip appears as the mouse is moved over the icon. 

KEY BLOCK

D
A
T
A 
   

B
L
O
C
K
S 

FIELD 

RECORDS/ 
ROW 

COLUMN 



Moving around a form  
Sometimes moving to other blocks will move you to another area on the same form, or sometimes it will 
open a totally new window displaying another block of information.  
 
To move to Next Block:  
Click Next Block from toolbar    OR 
Choose Next from Block menu  
 
 
 
To move to Previous Block: 
Click Previous Block from toolbar      OR 
Choose Previous from Block menu  

 
 

Use keyboard shortcut of CTRL PgDn or CTRL PgUp to activate Next Block/Previous Block 
command.  

To move to Next/Previous Tab: 
Click desired Tab OR  
Choose Tab from Options menu  
 
 
 
 
 
 

Use keyboard shortcut of CTRL Tab or CTRL Shift Tab to activate Next Tab/Previous Tab 
command or press F2, List Tab Pages, to display the tabs  
 
The close button on the form does not work the same as in other Windows environments- -
reactivate the original form by clicking on it. The other form(s) will hide in the background. 
When the original form is closed, all other forms will also close. 
 

To move from field to field:  
Choose Next from Item menu 
 
To move back from field to field:  
Choose Previous from Item menu  
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 Quick Tip Use keyboard shortcut of Tab or SHIFT Tab to activate Next Item/Previous Item command. Fields 

are sometimes referred to as Items.  

Once the cursor reaches the end of the available fields in a block, it will typically start again at the first field 
and continue to cycle through all fields in that block.  
 

To access fields that are in another block, you must move to the next/previous block first.   Quick Tip 

 Quick Tip 

 Quick Tip 

 Quick Tip 



Some forms are designed to display a list of records, such as a query form. These forms may not have 
blocks. 
 
To move from record to record:  
Click Next Record from toolbar OR  
Choose Next from Record menu  
 
 
 
 
 
 
To move back from record to record:  
Click Previous Record from toolbar  OR   
Choose Previous from Record menu  
 

 
Use keyboard shortcuts of the cursor arrow down and cursor 
arrow up.  
 

Options Menu  
The Options menu on the Main Menu bar contains navigation options that are frequently used. Navigation 
options vary from form to form and depend on the cursor location. Some options take you to other blocks 
and windows within the current form.  
 
Other options take you outside the current form to related forms. Choices selected from the Options menu 
will display additional areas that will allow access to further form data.  

 
The form names in parenthesis indicate that another 
related form will be accessed.  
 

 
 
Forms which are currently open may not be accessed 
again through the Options menu.  
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Additionally, right-clicking the form will 
activate the quick menu which provides 
access to related forms.   
 

 
Press F2, List Tab Pages, to display the tabs 
 

 Quick Tip 

 Quick Tip 

 Quick Tip 

 Quick Tip 



Rollback  
This feature provides an option to rollback to a previous area. That area could be to a key block or 
beginning field depending upon the type of form opened at the time of the rollback.  

 

Rollback is NOT an undelete feature or an undo feature!  

If changes have not been saved recently and the “rollback” is executed to the beginning of an area, Banner 
will usually prompt to save what has been done before rolling back. 
 
 
 
 
 
 
 
  
 
Click Yes to save any changes 
to the record before rolling 
back to the previous area. 
 
Click No to discard any 
changes to the record before 
rolling back to the previous 
area. 
 
 
Rollback works as follows:  
 
Application and Inquiry forms:  
Clears all information (except key information) and returns you to the first enterable field in the key block. 
If you enter changes and do not save them before trying to rollback, you are prompted to save.  
 
Validation forms:  
Returns you to the first enterable field on the form.  
 
Query forms:  
Returns you to the first enterable field on the calling form.  
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Using Wildcards  
The use of wildcards is essential to performing quality searches. Wildcards are characters that are used as 
placeholders for unknown letters.  
 

Wildcard Characters  
Use the wildcards, “ %” and “_” in defining the search criteria—without the quotes. The “%” character 
represents any number of unspecified characters. The “_” (underscore) character represents a single, 
unspecified character.  
 
Examples:  
To get these results:  Enter this criteria:  

All entries that contain “ma” in the name  %ma%  

All entries that begin with “ma”  ma%  

All entries that begin with “ma” but are only three 
characters  

ma_  

All entries that have “ma” as the last two characters  %ma  

All entries that have “m” as the second character  _m%  

All entries that begin with “s” but have only five 
characters  

s_ _ _ _  

 
 
The dropdown arrow is a search button.   
 
 

 

Using Object Search  
The Object Search window enables searching for items by the Banner seven (7)-character name code, 
description, type, or by any combination of the three.  
 
Name:  
The multi-character code that identifies all objects (i.e., FTMVEND, PPAIDEN, SPAPERS, etc.).  
 
Description:  
Words used to further describe the 
objects.  
 
Type:  
The category of objects (i.e., form, job, 
etc.).  
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To use Object Search to search for forms:  
1. Type in the 7-character name code, description and/or choose Form from the Type field  
2. Press F8 or Choose Execute from Query menu  

 
 
 
 
 
 
 
 
 

 

The Start button in the (GUIOBJS) form is used to open a form once it is located. The F8 or Execute 
Query command must be used to activate the search. If the Start button or Enter key is pressed, it may 
cause an error of no records to be retrieved.  
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Some of the searches are case sensitive!   Quick Tip  
 

3. Locate the desired item  
4. Double-click item  

or  
Click item  
Click Start  
 
 
 

 
 
 
 
 
 

 
To cancel a search once the Object Search (GUIOBJS) form has been opened, click Cancel twice or 
press Ctrl Q twice.  
 

 
 
It is also possible to search with wildcard characters directly from the Go To field. 
 
 

 

 Quick Tip 

 Quick Tip 

 Quick Tip 



Searching in a Form  
Some fields in a form enable searching for the correct data to input. Form fields that provide a search 
capability will have a search icon next to that field.  
 

Depending on the form, in addition to using the magnifying glass icon to search, you can type in 
part of the data into a field, along with a wildcard symbol, then press ENTER. A separate window 
will appear where you can choose from a list of found records or continue to search further using 
more criteria.  

 
To search on a form field:  

1. Open the form  
2. Place cursor in the field to 

search  
3. Click Search icon  
4. Choose the correct Option, if necessary  
5. Type in the known data (along with Wildcard, if necessary) in the correct field  
6. Press F8 to execute the query  
7. Double-click on correct record to place that data in the original form  
8. Continue filling out the original (calling) form  
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Advanced/Extended Search  
Some forms provide for extended or advanced options.  

1. Open the form  
2. Place cursor in the field to search  
3. Type in the known data (along with Wildcard, if necessary) in the correct field  
4. Press Enter key  
5. Choose the correct record from the Search Results drop-down list  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Use more criteria to limit search results by selecting the desired option buttons or typing in any 
additional criteria in the provided textboxes and clicking the Search icon.  

 

 
 
Customizing Banner  
Banner can be customized to make it more convenient and efficient for each individual user. There are 
multiple ways of customizing Banner, but the three most popular methods are detailed below.  
 

 Creating Personal Menus/Using My Banner  
 Creating QuickFlows  
 Changing Personal Preferences  
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Personal (My Banner) Menu  
My Banner is an area that is used to create your own personal menu of forms that is accessed on a daily 
basis. This is similar to favorites or bookmarks in your web browser.  
 
My Banner is displayed as the first menu area on the Main Menu. Initially My Banner is empty. My Banner is 
customized to individual selections.  
 
To customize the My Banner menu:  

1. Click on My Banner 
2. Double-click Empty or Organize My Banner. [GUAPMNU]  

 
 
 
 
 
 
 
 
 
 

 
Once My Banner has been customized, the menu will display Organize My Banner  
 
 

3. Choose the type of object to add to the personal menu from the 
drop-down list at the top, left corner of the screen  

4. Click the Sort Object List icon to list the objects alphabetically so 
that it is easier to find the desired  item  

5. Scroll through the left window pane of items, until the object to be 
added to the personal menu list in the right window pane  

6. Select (highlight) the item(s) to add  

7. lick the Insert Selection icon to add the item to the personal menu 

 
e changes to My Banner menu  

 
C

8. Click Save icon  
9. Click Exit icon  
10. Exit Banner  
11. Re-login to se
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To use the search features in this form, place the cursor in the left window pane, verify that 
 
no 

items are selected and press F7. Type desired search information (i.e., SP% to locate forms that 
begin with SP) about the item in area of the blank pane and press F8.  

 

 
Removing Forms from My Banner  
After adding forms to the personal menu, it may be necessary to remove certain forms from My Banner.  
 
To remove items from My Banner:  

1. Click on My Banner  
2. Double-click Organize My Banner [GUAPMNU]  
3. Select the items to remove from the right window pane  

 

 
4. Choose the Remove Selection icon to remove items from the My Banner menu  
5. Click Save icon  
6. Click Exit icon  
7. Exit Banner  
8. Re-login to see changes to My Banner menu  

 
The My Banner Maintenance and Copy Form (GUTPMNU) enables copying of a My Banner 
menu to or from another user.  

 

 
YSU Internet Native Banner Navigation Training 7.0 December, 2005 Page 24 
  

 Quick Tip 

 Quick Tip 



QuickFlows  
A QuickFlow is a series of forms that have been linked together into a set that will flow quickly from one to 
the next. Banner comes with some built-in QuickFlows that can be used and/or each individual user can 
create their own personal QuickFlows.  
 
To use a QuickFlow:  

1. Choose QuickFlow from File menu  
OR 
Type GUAQFLW from the Go field  

2. Click Search icon to search for the QuickFlow 
OR  
Type the QuickFlow code in QuickFlow text 
box  

 
3. Scroll through the list of QuickFlows in the top window pane  
4. Click on desired QuickFlow  
5. The list of forms included in the selected QuickFlow appears in the bottom window pane  
6. Double-click the QuickFlow 

from the top pane  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
The code and description of the selected 
QuickFlow appears in the QuickFlow form  
 

7. Click Start  
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8. Use and exit each form in the QuickFlow series  
9. At the last form in the QuickFlow, the QuickFlow Form (GUAQFLW) reappears  
10. Exit the QuickFlow form  

 
 
 A QuickFlow can be stopped at anytime by choosing Exit QuickFlow from the File menu.  
 
Skip any form that is presented in a QuickFlow without entering any data by closing the form as 
normal. If a message appears prompting to quit the form, click Yes. Once that form closes, the next 
form in the QuickFlow series appears.  

 

Creating your own QuickFlows  
Banner provides built-in QuickFlows, and the functionality of creating customized QuickFlows. 
QuickFlows can be created with any combination of forms except the following:  
 

 Main Menu (GUAGMNU)  
 Welcome to Banner Form (GUAINIT)  
 QuickFlow Form (GUAQFLW)  
 Security Maintenance Form (GSASECR)  
 Any query form (Q is the third character of the form name)  

 
To create a QuickFlow:  

1. Determine the code and purpose of the QuickFlow  
2. Identify all forms that must be accessed for the tasks to perform  

 
For Example:  
Code: JOB  
Purpose: Add jobs to Job Submission  
Forms needed: GJAJOBS, GJAPDEF, GJAPVAL, GJAPDEF  
 

3. Open QuickFlow Code Validation Form (GTVQUIK)  
4. Click Insert Record icon from toolbar  

 
5. Type new QuickFlow code and description in the GTVQUIK form fields  

 
 
 
 
 
 
 
 
 

6. Click Save icon from toolbar  
7. Exit the form  
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 Quick Tip 



 
 
 
A QuickFlow code can contain up-to-four characters.  

 

 Quick Tip 

8. Open QuickFlow Definitions Form (GUAQUIK)  
9. Type QuickFlow code ( QuickFlow text box at top of form  

Move to next block  
determined previously) in the 

10. 
 

 

 
11. All existing Banner forms appear in far left pane  

to QuickFlow  

he right side  

he QuickFlow forms will open in the order you list them on the 

13. Type code name of the forms in the order they should to appear in the 

 
o change the order of an already created QuickFlow, you must remove the forms and re-add them in 

14. Continue ad  order  
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12. Scroll, if necessary, to locate desired forms to add 
 

QuickFlow codes must be typed into the first column in t
 Quick Tip pane (or copy and pasted). Double-clicking on code (or dragging) will 

not work.  
 
T
GUAQUIK form.  

 Quick Tip 

QuickFlow in the right side pane  

 Quick Tip T
the desired order.  
 

ding forms in the desired
15. Click Save icon  
16. Exit the form  



Editing QuickFlows  
There may be times when additional forms will need to be added to or removed from a QuickFlow.  

o add additional forms to QuickFlow:  
GUAQUIK)  

h for correct QuickFlow by clicking on Search icon  

 from left pane  
r in the right pane  

 and paste codes  

 
o remove forms from a QuickFlow:  

m (GUAQUIK)  

h for correct QuickFlow by clicking on Search icon  

ckFlow remove  

nce a QuickFlow is d anently deleted.  

 

n help to eliminate confusion.  

o delete a QuickFlow:  
ode Validation Form (GTVQUIK)  

ox appears, click Yes  
 of QuickFlows  

 

 
T

1. Open QuickFlow Definitions Form (
2. Type QuickFlow code to edit  
OR  
Searc
3. Move to next block  
4. Locate form(s) to add
5. Type code names in the order to appea
OR 
Copy
6. Click Save icon  
7. Exit the form  

T
1. Open QuickFlow Definitions For
2. Type QuickFlow code to edit  
OR  
Searc
3. Move to next block  
4. Click form in the Qui
5. Click Delete Record icon  
6. Click Save icon  
7. Exit the form  
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O eleted – it is perm
 
 

Deleting QuickFlows  
Removing unused QuickFlows ca
 
T

1. Access QuickFlow C

 Quick Tip 

2. Select the QuickFlow to delete  
3. Click Delete Record icon  
4. If a Confirm Delete Alert b
5. The QuickFlow should no longer appear in the list
6. Click Save icon  
7. Exit the form  



Personal Preferences  
By default, Banner does not display the seven-character form names next to the descriptions in the Main 
Menu tree. This feature is helpful when beginning to use Banner.  
 
To display Form names:  

1. Choose Preferences from File menu  
2. Display Options tab 
3. Choose the desired Display Options and Alert Options 
4. Choose the desired User Color Options 

 
The User Interface Color Settings section customizes colors for various sections of Banner, such as:  
 

 Buttons, such as Cancel and OK (buttons in the toolbar are not included).  
 Canvas (white space) of all forms  
 Record highlighting  
 Scroll and separator bars  
 Code/Description prompts  
 Canvases within the main menu, including the broadcast message, menu, and menu tree canvases  

 
To change the color setting:  

5. Click on the dropdown arrow next to User Value  
6. Select the new color 

 
7. Click OK  
8. Click OK  
9. Exit Banner  
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10. Re-login to see changes to Banner menu  



The My Links tab customizes the Personal Links that appear on the main menu.   
 
To add a Personal Link:   

1. Click My Links tab 
2. Click in the User Value field for the link description  
3. Type a description for the link 
4. Click in the User Value field for the link  
5. Type the actual link  

 
(if you are typing a web link, you must include the http:// in front of the link (for example, 
http://www.ysu.edu/); if 
you are typing a form 
name, just type the 7-
character name of the 
form).  

 
Each of the six personal 
links are comprised of 
two records—the 
description and the 
URL/Banner object.  
Make sure that the 
description matches the 
corresponding URL or 
Banner object record 
 
Make sure that you do 
not have pop-ups 
blocked with any third-
party software—it can 
interfere with the 
performance. 
 
 
 

Help  
There are many resources available for getting more information on using Banner.  
 

Banner Bookshelf  
The Banner Bookshelf is a series of user guides and other documents that provide a general overview of 
features.  

 
Adobe Acrobat will launch to display the Bookshelf files.  
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http:///
http://www.ysu.edu/
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To access Banner Bookshelf:  
1. Click Bookshelf icon from the right side of the Direct Access bar  
2. Click Bookmarks tab on the left of the screen  
3. Widen the Bookmarks pane, if necessary, by dragging the border line to the right  
4. Click Expansion Plus Sign [+] of the desired item(s)  
5. Continue to drilldown until desired information is located  
6. Click desired bookmark link to read Bookshelf document  
7. Print or save the document as needed  

 

Online Help  
Help Center Link  
The Help Center link accesses the SCT Banner Help Center.   

Release 7.0 features a new online help system that contains information about forms and fields, as well as 
tasks you can perform with Banner. This help system runs in a web browser, and is available by choosing 
the Online Help icon on the toolbar or the Online Help option from the Help menu. Additionally, you can 
access online help by selecting the Help Center link on the main menu.  

For forms with no help, the Banner online help error page may not appear for Internet Explorer users who 
use IE’s “friendly” error messages by default. For optimal performance in IE, clear the Show friendly HTTP 
error messages check box that is located on the Advanced tab of your Internet Options.  

Accessing Online Help from a Form  
The Online Help icon and Help menu option initially display information about the form on which you 
are working.  
 
Accessing the Help Center  
If you want information about forms and tasks for another Banner product, use the Help Center link, 
which is available from the main menu of Banner, or from anywhere within the help system.  
 
Features of Online Help  
You can browse, search, and use the index to locate topics in online help.  
 
Browsing for Topics  
The Contents tab and the bread crumb trail both enable you to browse for topics categorically. Form and 
field information is organized by Banner module. Task information is contained under the Procedures 
heading.  
 
Searching for Topics  
The Search tab allows you to search for topics within the help system. You can also use your browser’s 
“search on page” feature to find specific text on a help page.  
 



Using the Index  
The Index tab provides an alphabetical listing of topics within the help system. When you enter the 
letters of a term, the index will scroll through the topics to the closest alphabetical match.  
 
Using the Field Link  
Many form descriptions are quite long, so sometimes you will find a link that goes to field descriptions on a 
separate page.  
 

Using Dynamic Help Query  
This feature is slowly being replaced by Online Help. Currently only a few forms have access to Online 
Help while most still have Dynamic Help Query. This feature is a built-in help system in Banner that gives 
information on specific fields, blocks, and forms used in Banner.  
 
Although there are two areas; SCT Banner and Local, all information is provided in the SCT Banner area.  
 
To use Dynamic Help Query:  

1. Access desired form  
2. Choose Dynamic Help Query from H

menu  
elp 

3. Choose item to receive help (either 
Form, Block, or Field)  

 
 
 
 
 
 
 
 

4. Check SCT Banner option  
5. Click Display  
 

All available help on that item will display 
 

6. Click Cancel twice when finished  
 
Help (Item Properties)  
This help feature is designed to display the programming properties of each item in Banner. 
 
To use Help (Item Properties):  

1. Access desired form  
2. Choose Help (Item Properties) from Help menu  

 
Although this is basically used for programming, there are attributes that may 
be beneficial:  
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 locate how many characters are available for a field 
 determine if a field is required 
 identify if a field is a query or update 

 

Show Keys  
This help option displays keyboard shortcuts and Oracle functions that could possibly be used in the current 
field, window, and/or form.  
 
To use Show Keys:  

1. Access desired form  
2. Choose Show Keys from Help menu bar  
3. Locate desired keyboard shortcut option  
4. Click OK  
5. Perform keyboard shortcut  

 
 
 
 
 
 

Calendar  
Banner has a built-in Calendar that can be used to view the current date and to place a particular date into a 
date field.  
 
To access the Calendar:  

1. Access desired form that contains date field  
2. Double-click field  

 
Calendar form (GUACALN) appears highlighting the current 
date 

3. Double-click desired date  
 
The current date in any date field can be populated 
by typing any character in the field.  
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 Quick Tip 



Calculator  

Banner also has a built-in Calculator that can be used similar to the 
Windows calculator.  
 
To access the Calculator:  

1. Choose Calculator from Help menu  
 

Calculator form (GUACALC) appears  
 

2. Perform desired calculation  
3. Click OK  

 
If the field is a calculated value, double-click on it to 
retrieve the calculator. Once the  calculation is complete, 
Click OK to return the value to the field.  

 

 
General Person Identification Form  
There are over 2,000 individual forms available in Banner, each with its own specific purpose and method of 
usage. Each functional area at YSU will have forms they use most often. However, one type of form will be 
used by most functional areas on a regular basis is the General Person Identification form.   This type of 
form is known by many Banner systems, but under different names. For example:  
 

 Student System: SPAIDEN  
 Finance System: FOAIDEN  
 Human Resources System: PPAIDEN  
 Advancement: APAIDEN  
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Each one of these forms, although named differently, contains and provides much of the same information. 
Each form is dedicated to its own Banner system.  
 

Example of Using General Person ID Form  
Before someone can be anything else in Banner, they must first be entered as a person or a non-person. (A 
non-person would be a company or corporation.) Before you can be a student, you must be a person in 
Banner; before you can be an employee, you must first be a person; before you can be faculty, you must first 
be a person, etc.  
 
The SPAIDEN Form is used by the student areas to input new people into the Banner system and/or to 
make changes to entry information. Since coming into the system through the SPAIDEN form, more 
than likely this person would be a student.  
 
If the person were originally entered through PPAIDEN, which is the Human Resources department 
General Person Identification form, they more than likely would be a potential employee.  
 
If the person were initially entered through RPAIDEN, which is Financial Aid’s General Person 
Identification form, they more than likely would be applying for Financial Aid before even applying as a 
student.  
 
If the person were being entered through FOAIDEN, which is Finance’s General Person Identification 
form, they were receiving some type of financial benefit without being first entered in by Human Resources 
or the student areas.  
 
If a person or company were being entered through FTMVEND, which is the Vendor Maintenance Form 
and accessible by multiple systems, they would be a Vendor (as a person or non-person). An individual 
person can be a Vendor as well as a company or corporation.  
 
Persons can also possess multiple statuses. For example, an employee can also be a student. A student can 
also be a vendor. A vendor can also be an employee and a student. Although each person can possess 
multiple roles, they are only entered into Banner once and only possess one “active” record within 
Banner.  
 
Before creating a new person/non-person record, SEARCH-SEARCH-SEARCH! It is 
imperative that before you enter a new record of any kind (person or non-person) into the Banner 
system that you thoroughly search to make sure that entry is not already in the system.  
 
Creating “multiple” active records for the same person/non-person will make it impossible to correctly 
maintain records and data integrity will be jeopardized. The full Data Standards document is available online 
at the YES website http://www.ysu.edu/YES.  
 



To use either SPAIDEN, PPAIDEN, FOAIDEN, FTMVEND, etc., to input a new person/non-
person:  
 

1. Access desired form  
2. SEARCH thoroughly (at least three times) to see if the person/non-person to input is not already in 

the system  
Once confirmed that the person/non-person is NOT already in the system  

3. Click Maintenance icon to generate new ID number  
Insert information on Common Matching here 

 
4. Move to next block  
5. Type in all necessary information.  
6. Access any Optional areas from the Options menu  
7. Click Save icon  
8. Exit the form  

 
 
 
 

Banner Messaging  
The View/Send Message icon provides the ability to send and receive messages from other Banner users at 
YSU. Messages are created and viewed on the General Message Form (GUAMESG).  
 
This is a method of communicating among Banner members from directly within Banner and does NOT 
generate e-mail messages to an Outlook/Netscape/CUE, etc., mailbox. Some internal Banner messages will 
generate automatically for specific processes (i.e. when a requisition has been approved).  
 
When a new message is available to view, the system displays a green checkbox the next time you return to 
the main menu. Returning to the main menu occurs when you access any form from the Go field, menu, or 
site map, and exit the form to return to the main menu.  
 
To display your messages at any time:  

1. Click the View/Send Message link from My Links  
 
The GUAMESG Form appears with messages  
 

2. Review messages  
3. Click Complete  
4. Click Save icon  
5. Exit the form
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To send messages:  
1. Click the View/Send Message icon from the main menu toolbar  

OR 
Access GUAMESG Form  
2. Type: Recipient ID  
3. Type: Date  
4. Type: Message  
5. Type: System  
6. Determine Confidentiality status  
7. Click Save icon  
8. Exit the form  

 
 
Don’t forget!!! If the message is not marked confidential, it can be viewed by many others.  
 
 

FOAPAL  
Financial activities, the paying of expenses and accounting for incoming revenues, are based on an 
organizational method of processing. This organization is based on the idea of a hierarchy of related 
financial events.  
 
The FOAPAL string of codes is the core of the Banner Finance System. FOAPAL is the hierarchy coding 
system used for classification, budgeting, and recording. It also gives users the ability of reporting and 
making inquiries at multiple levels.  
 

Acronym  COA  F  O  A  P  A  L  
Element  
 
 
 
Identifies  
 
 
 
 
 
 
Number of 
Characters 
per Field 

Chart of 
Accounts 

 
 

Framework for 
accounting 

structure 
 
 
 
 
 

 1  

Fund  
 
 
 

Where the 
money is 

drawn from  
 
 
 
 
 

6  

Organization  
 
 
 

Budget unit 
of the 

department 
processing 

the 
transaction  

 
 
6  

Account 
 
  
 

What 
financial 
activity is 

being 
recorded  

 
 
 
6  

Program  
 
 
 

Purpose of 
the 

transaction  
 
 
 
 
 
2  

Activity 
 
  
 

N/A  
 
 
 
 
 
 
 

6  

Location 
 
  
 

Physical 
Location  

 
 
 
 
 
 

6  
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Chart of Accounts is a systematic classification of accounts. YSU uses one COA: Y 
 
Fund identifies the source from which the money is being drawn.  
 
Organization identifies the department that is processing the transaction. 
Examples: President’s Office, Center for Urban Studies, College of Engineering 
and Technology.  
 
Account Code identifies the financial activity being recorded. Examples: assets, 
liabilities, fund balance, revenues, expenditures, transfer.  
 
Program identifies the purpose of the transaction. Examples: instruction, 
academic support. 
 
Activity is not currently used at YSU. 
 
Location is used only for fixed assets. 
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Exiting Banner  
Exiting Banner is a simple process. No matter where you are in Banner you can get out quickly and easily 
with no more than four clicks of the mouse.  
 
To exit Banner:  
1 Click Exit icon (blue and white [X])  
2 Click again, if necessary  
3 If an Alert box appears asking if you want to exit Banner, click Yes  
4 Close the active browser window  

 
Key Terminology 
 
System: 
A system is a term used to describe an overall area of administration within Banner. For example, Finance 
and Human Resources are both systems within Banner. These main level systems appear when you first 
login to Banner. They are displayed on the horizontal Products Link bar as well as in the vertical Main Menu 
tree. Systems will contain Modules and Forms. 
 
Module: 
A module is an area of administration within a system. For example, Accounts Payable is a module under 
the Finance System. Within the Accounts Payable module is information on the multiple processes that are 
required and the step-by-step instructions (procedures) for doing so. Modules will contain forms and may 
contain further sub-menus.  
 
Process: 
A process is the series of steps for completion of a particular feature in Banner. For example, Vendor 
Maintenance is a process that needs to be completed within the Accounts Payable module of the Finance 
System. 
 
Procedure: 
Procedures are the step-by-step instructions involved in completing a process. For example, some of the 
procedures for completing the Requisition process are as follows:  
 
1. Open the Requisition Form (FPAREQN). 
2. Type the word NEXT in the Requisition text box. 
3. Press Ctrl + Page Down on keyboard to move to next block. 
 
Forms: 
A form is an online Banner document used to enter and/or look up information in the database. The form 
is the most basic product available in Banner. Banner is simply a collaboration of multiple forms working 
together to achieve a specific goal. 
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Terminology 
Alert Box A type of dialog box that notifies you of a condition that may affect how you can 

enter information or the kind of information you can enter. It requires you to 
acknowledge the message before you can continue. 

Application Form Form used to enter, update, or query information. (Most application forms will 
have the letter “A” in the third position of the form name.) 

Block An information area on a form typically indicated by a solid line or separate 
window. 

Calling Form Form from which you clicked a button and accessed another form.  
Cancel Exits you from an Option List, List of Values, Editor window, or Dynamic Help.
Clear Form Clears all information and returns you to the first enterable field in the key 

information area. 
Commit Saves all changes entered since the last time you saved. 
Count Hits In query mode, counts the number of records that meet the search criteria and 

displays that number in the Auto Hint Line. 
Count Query Hits In query mode, counts the number of records that meet the search criteria and 

displays that number in the Auto Hint Line. 
Dialog Box A box containing information buttons such as Yes, No, or Cancel. Requires you 

to respond to it before you can continue. 
Down Use the <DOWN ARROW> key. Moves the cursor to the first enterable field in 

the next record, moves you lower on a List of Values, and moves you lower in a 
pull-down list. 

Drop-down List A drop-down list shows three or more values for a field. Any field with a down 
arrow icon contains a drop-down list. 

Edit Displays a window you can use to add, change, or delete text. 
Enter Query Puts the form into query mode and lets you enter search criteria to see what 

information is already in the database. Enter Query appears in the Status Line. 
Execute Query In query mode, searches the database and displays any records that match the 

search criteria 
Exit with Value From a called form, returns you to the calling form and enters the highlighted 

value into the field that called the form. From a List of Values (LOV), returns 
you to the calling form and enters the highlighted value into the field that called 
the form. 

Exit without Value 
 

From forms and windows, exits you out of the form or window without selecting 
a value. 

Field Area in a form where you can enter, query, change information, or where existing 
information is displayed. Banner describes fields as either enabled, disabled, 
enterable, or display only. 

Form Window containing enterable fields for a process. 
Help Displays the Oracle help window for the current field. (Online Help is gradually 

replacing SCT Banner Dynamic Help.) 
Inquiry Form Form used to look up existing information in the database. Allows you to view 

but not update. (An inquiry form will have the letter “I” in the third position of 
the form name.) 
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List of Values (LOV) 
 

Displays a list of values for the current field if List of Values appears in the status 
line. 

Menu A list of options you can access with the mouse or keyboard. 
Next Block Moves the cursor to the next information area (block) that has at least one 

enterable field. 
Next Field The next enterable field in the current information area. 
Next Item The next enterable field in the current information area. 
Next Record Means to move the cursor to the first enterable field in the next record of the 

current information area. If the cursor is in the last record, a new record is 
created. 

Object An object can be a form, job, menu or QuickFlow used in Banner. 
Online Help Provides information for Banner forms, windows, blocks, and fields. Online 

Help is gradually replacing the SCT Banner Dynamic Help. 
Option List Dialog box displaying two or more items to choose from. 
Previous Block The previous information area that has at least one enterable field. If the 

previous area is another window, then that window is opened. 
Previous Field Means to move the cursor to the previous enterable field in the current 

information area. 
Previous Item Means to move the cursor to the previous enterable field in the current 

information area. 
Previous Record Means to move the cursor to the first enterable field in the previous record. 
Query Form Form used to look up existing information on the database. (A query form will 

have the letter “Q” in the third position of the form name.) 
QuickFlow A set of forms that are linked together in order to help you complete a process 

within Banner. When you use QuickFlow, it opens the first form in the set and 
the next form is automatically opened until the process is completed 

Record All information displayed in the window for an item 
Rollback From an application or inquiry form, clears all information and returns you to the 

first enterable field in the key information area. Rollback is a standard button and 
appears on most forms. From validation forms, rollback will return you to the 
first enterable field on the form. From a query form it will return you to the first 
enterable field on the calling form. 

Save Means to save all changes entered. 
Scroll Down The process of moving down repeating records or lists of information that 

cannot all be displayed in one window. 
Select Choose an item by highlighting it or clicking it with mouse. 
Show Keys Display the list of keyboard options. 
Up Use the <UP ARROW> key. Means to move the cursor to the first enterable 

field in the previous record, moves you upward on a List of Values or drop-down 
list. Use the arrow key. 

Validation Form Form used to define the values that can be entered in specified fields on 
application forms. (A validation form will have the letter “V” in the third 
position of the form name. 

Window Displays an information area. 
 


